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Generalities
The*Drums is a complete universal sequencer/editor for all your drum parts. You can edit 
your patterns on the screen editor and chain them into a song.

Customize the instrument table up to 25 different instruments, choose the right 
Divisions/Beat ratio, select the MIDI channel and save the defaults into the configuration file.
You'll have up to 15 patterns to play in the sequence you define into the Song Vector; then 
save the standard Midi File song and import the file in your personal Midi sequencer, to add 
the rest of the orchestra.

Your drum pattern can be built editing on the static workspace, real-time editing, or real-time
recording from any MIDI instrument. 

NOTE:Only registered copies are able to generate Standard Midi Files.



Registration
Registration 

The un-registered version of The*Drums doesn't allow you to save Standard Midi Files or 
Copy SOng to Clipboard.

To register The*Drums send me a note and a traveller's cheque or money order (or 
VISA/MASTERCARD through Software Excitement! or CompuServe - see below) for $50 US. 
Please include in your note your name, mailing address, current version number and 
computer/MIDI setup.    The current version 
information is found in the File About dialog box.    If you would like a copy mailed to you, 
please add an additional $5, and I will send you the most recent version available.    

I will send your registration keys, which you can then use with the File Register command to 
unlock the program.    If you have a CompuServe    account, I will send the registration keys 
immediately via 
CompuServe    mail, otherwise I will have to send you an old fashioned letter or a fax (if 
available c/o you).

How to contact me:

              Fabio Marzocca
              Via Ificrate 33
              00124 Casalpalocco (ROME)
              ITALY

You can also reach me:

at my phone: (39-6) 505.3884

on CompuServe: User ID 100015,2217
on BiX:              fabio
on McLink:        mc3796

Software Excitement! 
The*Drums is distributed in the States also by "Software Excitement!". They
will accept registration fee (50 $) by credit card payment (VISA and MASTERCARD).

Please contact:

Software Excitement! Inc.
Attn: Registrations
6475 Crater Lake Hwy
Central Point, OR 97502

Phone (503) 826-8082
            (800) 444-5457
FAX      (503) 826-8090
              for orders only!

CIS Id: 71203,1301



CompuServe Software Registration Service 

For CIS users, the Regsitration Service of CompuServe will allow you to register The*Drums 
on line. Type GO SWREG at Cis' prompt.



Getting Started
GETTING STARTED
 
                What do I do first?

1. Copy the diskette on an hard disk directory. Install it from Windows Program Manager 
(File/New).

2. Click over The*Drums icon.

3. Edit the instrument table to fit it with your keyboard
                                              
4. Set the MIDI channel where you have the drum part
                                              
5. Set your favourite Divisions/Beat. and Beats per Measure.

6. Set your preferred default tempo
                                              

7. Save previous settings in the default file, so you will have them all each time you start 
The*Drums.
                                              
 8. Load an example file and press space (or click on PLAY) to play the selected pattern, or 
click on PLAYSONG to play the whole song.

9. Now you can directly edit the pattern while playing, or overdubbing in real time recording 
mode.



Hardware requirements
HARDWARE AND SOFTWARE REQUIREMENTS

Hardware:

- 80286, 80386 or 80486 CPU
- 1 mega RAM
- VGA video card
- Mouse
- A MIDI card or any Music Card compatible with Microsoft Multimedia
    Extension.

Software:

- Microsoft Windows 3.1



The File Menu

 This is the menu of command related to file storing and retrieving on/from the disk.

File/New  

This blanks the current workspace and re-load the default configuration file. If you have 
made changes to your work that have not been saved to disk, you will be asked if you would 
like to proceed
 with the command. If you choose to proceed, the work in memory will be completely 
erased.
 
File/Open 

Load a "The*Drums" file (.tdr)) from the disk into the workspace. If you have made changes 
to your work that have not been saved to
disk, you will be asked if you would like to proceed with the command.    A dialog box will 
pop-up with a list of files. 

File/Save  

Updates the current opened file with the new changes. If no file has been opened, you will 
be prompted to enter the file name.

File/Save As  

Save the current workspace into a new file. You are prompted to input the filename (without 
any extension). On the new patterns file, following data will be saved:

                                15 patterns data
                                the tempo setting
                                the instrument settings
                                the Divisions/beat

Save MidiFiles 
Save the current song in a Standard Midi File - format 0 or format 1. The format 0 will save 
all your song into one track, as usually done by most of the commercial sequencers. The 
format 1 will generate a separate track for each played instrument.

To allow this function you have before to set the song vector pattern list. The resulting 
standard MIDI file will take also care of the quantization setting, channel and tempo.

File/Import MIDI file 

This function will allow you to load Standard Midi Files generated by other programs. 
Before accessing the File/Import function, you need to be sure that the Instrument table you 
have loaded is coherent with the one inside the Midi File to read.
Specify in the dialog box how many measures you    want to load and from which channel. 



The*Drums will then try to do his best to fit the MIDI file measures into equivalent patterns. 
When you have finished to edit the file, remember to Save As ... it.

File/Registration 

This is the function to enter your registration fields, you will receive after the registration will
be processed. Be careful to enter correctly the uppercase/lowercase sequence. This function 
will be inhibithed upon correct registation will be entered.

File/Quit  

Quits the program.



The Screen Editor
The graphic Screen Editor workspace will let you create your own patterns to be linked into 
the song.

First of all, you'll have to decide the best Divisions/beat ratio. Clicking over the proper button
in the tools space, a dialog box will pop-up with a    large variety of choices.

If you don't have already configured your workspace, load an instrument file (if your synth is 
in the instrument list) or edit the displayed instruments. You can edit them through the 
Instruments Editing function, or double-clicking with the left mouse button on the instrument
name.

Once you have fixed the Divisions, you can start building up your pattern, clicking into the 
boxes. To change the volume of the specific instrument tick, set the proper loudness on the 
corresponding loud check box (30,60,90, or 127).

Give a name to your pattern, in the pattern name edit box (over the pattern map), in order 
to better remind the job of the specific pattern (i.e. INTRO, FILL-IN, MAIN, etc)

You can also edit in Real-Times while the pattern is playing.



The Song Vector
In the Settings Menu, you have the Song Vector choice. You can reach it also pressing on the 
Song Vector button on top of the workspace.

In the Song dialog box you will have represented in the lower part the 15 patterns symbols 
and a STOP icon. Dragging these icons into the right measures, you can build your song 
sequence. Remember to put the STOP icon right after the last filled measure.

From this box you can also play the entire song, clicking on the Playsong button. During 
editing you should need to play one pattern to remember the groove: just click over the 
pattern icon with the RIGHT mouse button to start a pattern loop. Press STOP to finish.

If you don't set up a song vector, you will not be able to save a Standard Midi File or to Copy 
the song in the Clipboard.



Playback
When you click over the Play pushbutton, the displayed pattern will start playing, at the set 
tempo rate. The pattern will play back in an infinite loop, until you stop it.

If you have already set up a Song Vector, you can play all the song clicking over the Play 
Song button. In such a case, The*Drums will play all your song until the end, and then it will 
stop.

Keyboard Shortcuts:

The Space bar acts as a toggle-switch between the Play Pattern and the Stop Play functions.



Instruments editing
If you don't find your synth in the .kbr files in the distribution disk, you can create your own 
settings with the Instruments choice in the menu bar.

After the editing pop-up dialog box appears, you are requested to enter the name and the 
corresponding synth key setting for that instrument (in decimal value). This value should be 
easly found on your synth manual.

After having completed all the settings, save the file with a name. If you want to make these 
settings as default at program start, save also the configuration with the Settings choice in 
the menu bar.



Configuring The*Drums

Configuration 
Before you can play a song the MIDI hardware must be configured. The first time you run 
The*Drums, a configuration box will pop up.    You must do this before you can play. 
The dialog box displayed is used to select the proper MIDI output and input devices .
Once you have successfully configured The*Drums, this configuration information is 
remembered in the THEDRUMS.INI file, so you should only have to configure once.    The 
configuration is also tested whenever The*Drums is started, to make sure your equipment 
has not been changed.
If you need to change the MIDI devices, you can access the MIDI Configure function in the 
Settings menu.

Configuring for Non-Standard Installations 
If you know what your configuration is, simply select the appropriate settings and press Ok.   
When Ok is pressed, the device will be tested (a reset is performed), and if all is well, the 
device is configured.
If you don't know what your configuration is, you will have to resort to the old trial and error 
approach.    You can try various settings until you find the correct one.    Note that The*Drums
will probably detect an incorrectly set base I/O port address, and give you the message: 
"Configuration Failed."    If your machine simply hangs without giving you any warning (big 
red switch time), then the base I/O port is probably correct but the interrupt number is 
wrong.    Try again with the same base I/O port address and another interrupt number.

 



The Edit Menu

AUTO-GENERATOR 

This feature    allows to fill an instrument pattern automatically and random. This will help in 
giving a new "Human Feel" to your patterns, by selecting the percentage of the instrument 
presence. Build the essential parts of your rhythm, and then auto-fill a snare, a cup, or 
whatever you think could give you much realistic sounds. Input in the dialog box the 
percentage of instrument fill and the loudness at which you want the new notes entered.

CLONE PATTERN 

It could be easier to edit an already made pattern, than to create a new one from a white 
paper. So, when you have built the main rhythm, copy the pattern into a blank one. This 
command will let you 'clone' one pattern onto another.

BLANK PATTERN 

Blanking the pattern will erase the entire displayed worksheet. Other patterns in your file will
not be erased.

CLEAR BEAT/CLEAR INSTRUMENT

Selecting these options you could erase the notes of a single instrument or a single beat.

COPY SONG 

This function will save the song to the Windows Clipboard, to allow data exchange with other
Windows Applications.



TheSettings Menu
Timebase 

This command sets the number of "ticks per beat" used in a drum song.    This effects the 
resolution of a song's timing.    In standard time (4/4), the number of ticks per beat is the 
number assigned to a quarter note.

The default timebase is 120.    The Roland MPU-401 supports timebases from 48 to 192.    The
other supported timebases are mapped internally by MidiLib to one of these timebases.    
The normal minimally acceptable timebase is 96.

Song Vector

See the SONG VECTOR paragraph in this file.

Save Defaults 

When program starts, it reades the file td3.cfg which contains:
- Instruments key setting
- the MIDI channel 
- the default Divisions
- the default tempo

To modify this file, set up your preferences and use this option to save the file.

MIDI Configure 

Access this function to change your MIDI output or input device. The input device is not 
mandatorily requested to playback, but you need it if you want to record from your 
keyboard.
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Play a single instrument

While editing, you can point on one instrument line and press the
RIGHT mouse button. This will sound one shot of the selected instrument.
Nice to hear at the instrument sound if you are not sure about how
it feels.



Note to Cakewalk users
The Cakewalk for Windows (WinCake) users will find a useful function in the Copy Song  of 
the Edit Menu. This will allow them to easily export the song in the Windows Clipboard, 
switch to WinCake application and, from there, paste to One track the entire drum song.
This will superseed the need to save to a file and then retrieve, wasting time.
The*Drums uses the Standard MIDI File format for the Clipboard as WinCake does, allowing 
the data exchange from the two applications.

Further to this, if you are running an MPU401, install the 12Tone Systems driver in place of 
your Windows mpu401.drv. This will allow you to run The*Drums and WinCake 
simultaneously, listening to the music playing while testing your drum pattern!

Thanks to Greg!



Real-Time Editing
You have the incredible capability to edit your pattern in real time, while it's playing, without 
loosing the syncro. Just click on the Play button (or press the Space Bar) and build your 
rhythm in real time. You'll have the immediate feedback of all your entries into the 
workspace.

While playing you can:

- Add notes at the choosen loudness;
- Delete notes;
- Clear a beat;
- Clear an instrument;
- Autofill an instrument;
- Change the pattern;



Real-Time Recording
By pressing the RECORD button you will enter into real time MIDI record function. From now 
on, each key pressed on your keyboard, if on the matching channel, will be recorded in real-
time into your pattern. Look at the sqares appearing as you play! The real time editing 
funtion is still available while recording, so you can mix the live techniques with the editing 
fine tuning. The*Drums will detect also your key-velocity and translate it into the 4 loudness 
ranges.

Keyboard shortcuts:
Pressing Alt-R will enter in Record mode.






